LOYOLA UNIVERSITY CHICAGO

FORMATTING MANUAL FOR THESES AND DISSERTATIONS
WITH INFORMATION ABOUT FINAL COPY SUBMISSION

AN ORIGINAL HANDBOOK SUBMITTED TO
STUDENTS OF THE GRADUATE SCHOOL
WITH THESES AND DISSERTATIONS FOR THE DEGREE OF
MASTER OR DOCTOR OF PHILOSOPHY

PROGRAM IN THE GRADUATE SCHOOL

BY

FORMATHELP@LUC.EDU
GRANADA CENTER 413 | 1032 W. SHERIDAN RD.
CHICAGO IL, 60660
ACKNOWLEDGMENTS

I would like to thank all the people who made this handbook possible, starting with my wonderful predecessors in the Graduate School at Loyola University Chicago. Thank you to Will Farina, who tirelessly made this manual before my time as formatting assistant. Alas, a revision was necessary in the summer of 2022, but your work, Will, is acknowledged and carried forward with this edition. Thank you to Dr. Lydia Craig who allowed me to use her well-formatted dissertation as an example here in this manual and in many an email to students in the throes of formatting challenges. Thank you also to Heather Sevener, the assistant dean, for allowing changes to our guidelines that should greatly improve the formatting process for students in the arts and sciences.

I would also like to thank Loyola University Chicago for providing this assistantship which has given me much needed support while working toward my own doctoral degree in English. The process- and detail-oriented formatting work has proved to be a nice balance to graduate work in literary theory and criticism, and the merit award has made my dissertation research and writing possible.
Dedicated to my fellow graduate students.
May your formatting be swift, and your final copies impeccable!
I would prefer not to.
—Herman Melville, “Bartleby the Scrivener”
# TABLE OF CONTENTS

**ACKNOWLEDGMENTS** iii  
**LIST OF TABLES** iii  
**ABSTRACT** ix  
**INTRODUCTION** 1  
Format Check Deadlines 1  
Format Check Correspondence 2  
**CHECKLIST OF REQUIREMENTS FOR GRADUATION** 3  
RCRS Training 3  
IRB Approval 3  
GSPS Approval 3  
Oral Defense 3  
Format Check 4  
  Supplementary Files 4  
  Final Copies 4  
  Approval Sheet 5  
**FORMATTING** 7  
General Formatting Requirements and Guidelines 7  
A Note Regarding Word Processing Software 7  
  Margins 7  
  Spacing 7  
  Divisions and Subdivisions 8  
  Typeface/Font 8  
Page Numbering and Placement 8  
  Front Matter 8  
  Body Text and Back Matter 9  
Margin Requirements 11  
Formatting Front Matter 12  
  Title Page 12  
  Copyright Page 14  
  Acknowledgments (Optional) 14  
  Dedication (Optional) 15  
  Epigraph (Optional) 15  
  Preface (Optional) 15  
Table of Contents (TOC) 16  
Preliminary Lists 17  
Abstract (Optional) 18  
Formatting The Body Text 18  
  Chapters 18
Subheadings 20
Tables and Figures 20
Landscape Pages 21
Sources and Citations 21
Quotations 22
Citations and Footnotes 22
Style Manuals 22
Editing Help 22
Formatting Back Matter 23
Appendices 23
Appendix Material 23
Bibliography or Reference List 24
Vita 24

EDITING YOUR DISSERTATION OR THESIS 25
Punctuation 25
Dashes 25
Ellipses 25
Colons 25
Spacing 25
Lists 25
Typefaces 25
Grammar 26
Using a Style Sheet 26
Some Common Issues 26

SUBMITTING THE FINAL COPIES 27
Guide to Electronic Submission of the Final Copy 28
Publishing Options 28
Dissertation/Thesis Details 28
Copyright 28
Ordering Bound Copies 28
Survey of Earned Doctorates (SED) 28

APPENDIX A: SUPPLEMENTARY ABSTRACT AND TITLE PAGE 29

APPENDIX B: APPROVAL SHEET 32

APPENDIX C: HEADING HIERARCHIES FOR MAJOR STYLE MANUALS 35

APPENDIX D: LANDSCAPED TABLE WITH PAGE NUMBER 41

APPENDIX E: COMMON FORMATTING ISSUES AND THEIR SOLUTIONS 43
LIST OF TABLES

Table 1. Deadlines for Graduation, Format Check, and Final Copy 5

Table 2. Pagination 10

Table 3. Top Margin Requirements 11
ABSTRACT

This manual gives you everything you need to know about formatting your thesis or dissertation, including submission instructions for your final copy. The manuscript you submit for a format check must be formatted according to the guidelines established in this manual. At least 50% of the body text must be present for format check, along with front and back matter. Our website has additional resources including a blank version of the checklist used to give feedback, and templates for each necessary section.

There are two general ways to go about formatting your dissertation or thesis. The first is to use section breaks between areas with different formatting requirements. You may find it helpful to turn on the show/hide formatting option in Word. Additionally, on the bottom left of your Word screen, right click on the bar showing your word count and page count. Select “Section” near the top so that you always know which section you are in as you format. If you choose not to use section breaks, you can create different Word files for every section/chapter. Save each chapter as a PDF and then compile into one complete document when you have finished all formatting. You may wish to rely on both methods, possibly creating a new document for each chapter, where you manually start the page numbering where the previous one left off.

The formatting of this manual itself closely resembles all our requirements and protocols. There are some deviations, such as areas using some single-spaced text, and not using 2” top margins for major divisions. Please see Appendix E for common issues and their solutions. Feel free to email me at formathelp@luc.edu if you need an example of any other section not presented here.
INTRODUCTION

This manual provides information about all of the necessary formatting requirements for final copies of dissertations and theses submitted to the Graduate School at Loyola University Chicago. Dissertations and theses must follow every one of these formatting rules. Final copies that do not meet the requirements established by this manual will not be accepted, and students whose manuscripts do not meet the formatting requirements will not be permitted to graduate. Proper formatting can take a great deal of time; we recommend you begin formatting as soon as you begin writing in order to save yourself time and effort later.

This manual generally follows the Chicago Manual of Style but offers flexibility for disciplinary differences. When the rules in your style manual conflict with the rules established by this manual, this formatting manual will supersede yours.

Format Check Deadlines

Before submitting a final copy of a dissertation or thesis, every student must electronically deliver a draft version of the manuscript to the Graduate School, where it will be checked by the format check administrator. At a minimum, this draft should demonstrate your best efforts to follow all the rules laid out in this handbook. If the draft’s presentation does not reflect this, then you will be required to submit for a second format check and may not receive a full checklist, but instead be directed to review this handbook and our other resources (like the blank checklist) before resubmitting.

You must electronically deliver your manuscript to the Graduate School via the ProQuest ETD site ON OR BEFORE the published format check deadline for the term in which you expect to receive your degree. If you do not complete every step for electronic submission in the ETD site, your manuscript will not be received by the Graduate School, and you will risk missing the deadline. We strongly recommend beating, rather than meeting, these deadlines. Our deadlines are always at the beginning of the month and are as follows:

- MAY degree conferral: Submit for Format Check by MARCH 1
- AUGUST degree conferral: Submit for Format Check by JUNE 1
- DECEMBER degree conferral: Submit for Format Check by OCTOBER 1

Format checking is done only through ETD. Manuscripts submitted as email attachments or in hard copy will NOT be accepted. The ONLY way to submit a manuscript to the Graduate School for the format check requirement is to upload it as a PDF to ProQuest’s Electronic Thesis/Dissertation (ETD) administrator: http://www.etdadmin.com/luc. Any and all successive
versions of your thesis/dissertation must be uploaded through your same account. If you have not received a format check checklist 9 days after submitting, please email formathelp@luc.edu. Note that we try to do a format check on your draft within 7 days, but that sometimes this time can be slightly longer around the deadlines. To avoid a wait, please submit early.

Format Check Correspondence

After you submit your manuscript to the Graduate School via the ETD site, you will receive email confirmation of your submission. If you have concerns about whether you completed the process correctly, you may email the format check administrator at the address below.

After your format check is completed, a worksheet detailing the corrections you must make will be sent to the email address you used to create your ETD account. You are highly encouraged to use the blank version of this checklist, provided on our website, as a tool to check yourself when editing your own manuscript before initial submission.

There is only one format check administrator, and there is often a queue of manuscripts to be checked. If you have submitted a manuscript for a format check and have not received feedback within 9 days, please send an email to formathelp@luc.edu to make sure your submission was received.

If you are required to submit a revised manuscript for a second format check, you may do so by uploading a revision in your existing ETD account; do not create new or multiple accounts in ETD. Make sure to fully submit your revision; your upload will not show up unless it is fully submitted.

If you are submitting for a future conferral period—later that the conferral period that is currently approaching—then it may be some time before you receive feedback.
CHECKLIST OF REQUIREMENTS FOR GRADUATION

RCRS Training

All Ph.D., M.S. and M.A. students* who are writing a dissertation or thesis must successfully complete the Responsible Conduct in Research and Scholarship training as part of the degree requirements. It is strongly recommended that students complete this two-day training before beginning the dissertation/thesis stage of the program.

More information can be found here: http://www.luc.edu/ors/RCRHome.shtml

*Education and Nursing students receive separate RCRS training.

Research Compliance (if applicable)

All research projects which will involve human subjects, whether funded or unfunded, must be submitted to the IRB for review. Research conducted by an investigator affiliated with Loyola at an off-campus site(s) or in collaboration with an investigator at another institution must still be submitted to the Lakeside IRB. For non-Lakeside programs, please consult with Graduate Program Director for appropriate IRB.

Principal investigators and course directors must obtain approval from the IACUC before initiating any research, testing or instructional project involving the use of live vertebrate animals.

More information can be found here: http://www.luc.edu/ors

GSPS Approval

All students writing a dissertation or thesis must create a committee and have it approved through the Graduate Student Progress System (GSPS) before a proposal can be approved. Once a proposal has been written and successfully defended, the student must start the proposal page in GSPS. Approval requests will automatically be sent out to the committee members and Graduate Program Director. Once the Graduate School approves the proposal, the student can conduct the research.

Oral Defense

A public oral defense is required of all dissertations and most theses (see individual programs' requirements). The results of the committee's evaluation of the text and oral defense are noted on
the APPROVAL BALLOT FOR TEXT AND ORAL DEFENSE OF A THESIS
/DISSERTATION, which will be signed by the student’s committee members and uploaded to
GSPS by the student’s Graduate Program Director as soon as possible after the defense.

Format Check

Before submitting a final copy of a dissertation or thesis, every student will electronically deliver
a correctly formatted copy of the manuscript to the Graduate School, where it will be checked by
the format check administrator.

The format check may be completed before or after the oral defense, but the manuscript must be
submitted on or before the published deadline for format check in the semester in which you
wish your degree to be conferred. The format check deadlines are as follows:

- MAY (Spring) degree conferral: Submit for Format Check by MARCH 1
- AUGUST (Summer) degree conferral: Submit for Format Check by JUNE 1
- DECEMBER (Fall) degree conferral: Submit for Format Check by OCTOBER 1

Supplementary Files

You must also submit the following items in PDF as supplementary files in your ETD account on
or before the format check deadlines listed above.

- Title Page (formatted with the name of your director. See p.31 for an example)
- Stand-alone Abstract (with proper header. See p.30 for an example)
- Approval Sheet (formatted correctly with your information. See p.33 & 34)

Without also submitting these items upon the deadline, you may not receive credit for
completing format check and your degree conferral may be delayed. Examples can be found at
the back of this manual and as templates on our website.

Final Copy

Your final copy submission will be through ETD, just like the format check. The final copies
deadlines are as follows:

- MAY (Spring) degree conferral: Submit Final Copy by APRIL 1
- AUGUST (Summer) degree conferral: Submit Final Copy by JULY 1
- DECEMBER (Fall) degree conferral: Submit Final Copy by NOVEMBER 1

If your materials are incomplete or inaccurate, the Graduate School will notify you. If the
required corrections are extensive or take too long to complete, you may not be permitted to
graduate, and the Graduate School will delay conferral of your degree until the appropriate
semester.
Approval Sheet

The Approval Sheet is a form made by the student, signed only by the committee chair, and submitted as a scanned copy with the final copy of the thesis or dissertation as a supplemental PDF file in ETD. You must prepare an approval sheet for your dissertation or thesis director to sign and date. This is not available on the “Forms” page. You must format your Approval Sheet by copying the example available in APPENDIX B of this manual. It will become part of your alumni file.

Final approval of the text of a thesis or dissertation occurs after all required changes have been made to the text, at which point the director of the thesis or dissertation will sign the Approval Sheet.

The Approval Sheet confirms that the text you are submitting as a final copy to the Graduate School is the final text, incorporating any changes, revisions, or additions required by your committee at the time of your oral defense. Once your director signs this sheet, you may not make any further changes to the content of your manuscript without the consent and approval of your director.

(Please note that the Dissertation/Thesis Approval Sheets are NOT equivalent to or interchangeable with the Approval Ballot for Text and Oral Defense. The Approval Ballot confirms that the text and oral defense have fulfilled the requirements detailed by your department in conjunction with the Graduate School, and that you are eligible therefore to graduate with the degree you are pursuing. Every member of your committee and your Graduate Program Director must sign and date this form, which is available on the “Forms” page of the website. It will be uploaded to GSPS by your GPD.)

Table 1. Deadlines for Graduation, Format Check, and Final Copy

<table>
<thead>
<tr>
<th>Term</th>
<th>Apply for Graduation on or before</th>
<th>Submit for Format Check on or before</th>
<th>Submit with revisions on or before</th>
<th>Month in which degree will confer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spring Conferral</td>
<td>December 1</td>
<td>March 1</td>
<td>April 1</td>
<td>May</td>
</tr>
<tr>
<td>Summer Conferral</td>
<td>February 1</td>
<td>June 1</td>
<td>July 1</td>
<td>August</td>
</tr>
<tr>
<td>Fall Conferral</td>
<td>August 1</td>
<td>October 1</td>
<td>November 1</td>
<td>December</td>
</tr>
</tbody>
</table>
FORMATTING

A dissertation/thesis has three main parts: the front matter, body text, and the back matter. The following is a list of all of the possible elements of a dissertation in the order in which they appear. Some of these are optional and may not be appropriate to your project. Required elements are highlighted. If any of these required elements are not included in your manuscript or are missing essential information (such as page numbers) you will be required to submit for a second format check:

Front Matter
- Title page
- Copyright page
- Acknowledgments
- Dedication
- Epigraph
- Preface
- Table of Contents (required if you have chapters)
- List of Tables (required if you have tables)
- List of Figures (required if you have figures)
- List of Abbreviations, Schemes, etc.
- Glossary
- Abstract

Body Text
- The text and main content of your dissertation or thesis

Back Matter
- Appendix/Appendices
- Bibliography or Reference List
- Vita

Examples of each section of the thesis/dissertation may be found at this address. They should be used as guides, not as templates, as their margins are not necessarily accurate for printing: http://www.luc.edu/gradschool/academics_examples.shtml.

The formatting requirements are the same for theses as for dissertations. The only difference is that a short thesis does not require chapter sections. If you do not have chapters, you do not need the Table of Contents, but you may use one if you like.
A Note Regarding Word Processing Software

You will submit your drafts in PDF. The software you choose to create your draft may impact how the document is assembled and how it appears in PDF. Please note that The Graduate School expects the formatting assistant to be familiar with Microsoft Word formatting and able to assist you with making the changes necessary to achieve a given element of your manuscript (margins, page numbers, image placement). Your discipline may use other software to create manuscripts (for example, LaTeX) that is particularly useful in your discipline, but our formatting assistant will not be responsible for assisting with the technical details regarding adjustments that must be made in the settings of those programs in order to comply with our formatting requirements. Please confer with your Graduate Program Director for recommended templates or other assistance.

Margins

Every page of your dissertation or thesis will typically have 1-inch margins on all sides. The only exception to this is that the first pages of some sections must have a 2-inch top margin. We will indicate where this will occur in this section’s information.

A 1-inch margin means 1 inch of measured space from the edge of the page to area where text may appear. You may have to set the top margin just slightly larger than 1” (such as 1.1”) if your page number is being encroached upon. The margin and page number size/location in this manual are correct, so that you can compare to your own draft. Depending on your settings, you may have to set margins to something other than 1” to get them to appear at 1”. See Common Issues and their Solutions in Appendix E.

Please note that the formatting assistant does not check the settings you use, as they are reading your copies in PDF. They will physically measure the space created. You must be consistent within your draft. If your word processing program pushes your bottom lines onto the next page at the start of a new paragraph, that’s okay. The most important thing is that each page is the same and as close to 1” as possible without typing overttop the page number.

Spacing

Double-spacing is required throughout the text, with the following exceptions:

- Block quotes will be single-spaced.
- Footnotes will be single-spaced within the note and double-spaced between footnotes.
- Bibliographic material will be single-spaced with a double-space between entries.
- There must be no extra space between paragraphs or before/after subheadings (except when a subheading would end a page).
- All text will be aligned to the left margin to produce a ragged right edge. Do not justify
the text left-right or expand the character spacing.

Divisions and Subdivisions

✓ Chapters will be formatted according to the rules set in this manual. If you do not have chapters, your major divisions in the body text will still be formatted like chapters.

✓ Further divisions (subheadings) must follow the heading hierarchy established by the style manual appropriate to your discipline. Learn and follow what is conventional in your field. See APPENDIX C for different subheading styles.

Typeface/Font

✓ You must use the same typeface throughout your entire dissertation or thesis. This means that the typeface you use for your text must be used for all front/back matter, all footnotes or citations, all titles, all figure and table text, and all page numbers.

✓ We recommend setting your manuscript in the same typeface as this handbook: Times New Roman. If you would like an alternative, use one of the following: Georgia, Baskerville, Garamond, Palatino, Verdana.

✓ Indent all new paragraphs at .5” inch.

✓ The typeface you use must be able to be embedded when you convert to PDF format.

✓ You may set footnotes in a size 1 or 2 points lower than that used for the text. E.g., if you use Times 12 for your text, you may use Times 10 or 11 for your notes.

✓ Block quotes will be set in the same size font as the rest of the text.

Page Numbering and Placement

Every dissertation has three parts: front matter, body text, and back matter. The front matter includes every section that appears before the first page of text. The sections in the front matter provide the reader with a map of your project: how your project is structured as well as where to find all of your chapters, tables, figures, and illustrations. If you include acknowledgments, your reader learns a little about the communities that made your project possible. If you include an epigraph, preface, or abstract, your reader learns about the major themes, questions, and problems around which your project is oriented.

Front Matter

✓ Front matter includes all the pages that precede the text of the dissertation or thesis.

✓ Pages that do not take page numbers still count in the pagination of your manuscript. So, the title page is page i, even though it will not display a page number.

✓ The title page, copyright page, dedication, and epigraph will not bear page numbers but still count in the pagination of your manuscript.
√ All other front matter pages will display page numbers.
√ All front matter pages that display page numbers will be paginated with lower case roman numerals centered in the bottom of the page.
√ The page number must be 1 inch from the bottom of the page. This means that the bottom of the page number will be 1 inch from the edge of the page.
√ If you choose to include an acknowledgments page, it will begin on p iii.

**Body Text and Back Matter**

√ Count and number all pages.
√ The first page of text must be numbered 1. This will be either the first page of the introduction or the first page of chapter one.
√ Arabic numerals will be used consecutively from the first page of text to the last page of your vita.
√ Unlike older versions of this manual, page numbers will be placed on the top right for all pages in the body text section. Back matter will have page numbers in the bottom center of all pages. All page numbers should appear exactly 1” from edge of page. In other words, bottom page numbers will be 1” from the bottom edge of page, and equidistant between left and right edges of the page. Top-right page numbers will be 1” from the top edge of the page, and 1” from the right edge of the page.
Table 2. Pagination

<table>
<thead>
<tr>
<th>Front Matter</th>
<th>Type of numeral</th>
<th>Placement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title Page</td>
<td></td>
<td>Do not display</td>
</tr>
<tr>
<td>Copyright Page</td>
<td></td>
<td>Do not display</td>
</tr>
<tr>
<td>Acknowledgments</td>
<td></td>
<td>Bottom center</td>
</tr>
<tr>
<td>Dedication</td>
<td>lower case</td>
<td>Do not display</td>
</tr>
<tr>
<td>Epigraph</td>
<td>roman case</td>
<td>Do not display</td>
</tr>
<tr>
<td>Preface</td>
<td>roman numerals</td>
<td>Bottom center</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>roman numerals</td>
<td>Bottom center</td>
</tr>
<tr>
<td>List of Tables</td>
<td></td>
<td>Bottom center</td>
</tr>
<tr>
<td>List of Figures</td>
<td></td>
<td>Bottom center</td>
</tr>
<tr>
<td>Any other list</td>
<td></td>
<td>Bottom center</td>
</tr>
<tr>
<td>Abstract</td>
<td></td>
<td>Bottom center</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Text</th>
<th>Type of numeral</th>
<th>Placement</th>
</tr>
</thead>
<tbody>
<tr>
<td>All pages, other than</td>
<td>Arabic numerals starting with 1 on page 1 of text</td>
<td>Top right</td>
</tr>
<tr>
<td>rotated landscape pages.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Back Matter</th>
<th>Type of numeral</th>
<th>Placement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appendix cover pages</td>
<td>Arabic numerals</td>
<td>Bottom center</td>
</tr>
<tr>
<td>Appendix materials</td>
<td></td>
<td>Bottom center</td>
</tr>
<tr>
<td>Bibliography</td>
<td>continuing from text</td>
<td>Bottom center</td>
</tr>
<tr>
<td>Vita</td>
<td></td>
<td>Bottom center</td>
</tr>
</tbody>
</table>

Note. Every page of your dissertation or thesis has a page number, but not every page will show one, and some will be located in different places. Front matter will be paginated with lowercase roman numerals at the bottom center of the page. The text and back matter will be paginated with Arabic numerals. Table 1 displays pagination requirements in a quick-reference guide.
Almost all your margins should be 1 inch on all sides. Some pages, however, require a top margin of 2 inches. You set up settings that are different from the previous pages in MS Word via Insert > Section Break (new page). See Appendix E for more details on sections. Finally, there are a few pages on which the text must be vertically aligned and centered top to bottom once all margins have been set at 1 inch. In MS Word, centering text top to bottom can be achieved in Format > Document > Layout > Page > “Vertical Alignment: Center”

Table 3. Top Margin Requirements

<table>
<thead>
<tr>
<th>Front Matter</th>
<th>Top Margin Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title Page</td>
<td>center text top to bottom</td>
</tr>
<tr>
<td>Copyright Page</td>
<td>center text top to bottom</td>
</tr>
<tr>
<td>Acknowledgments, first page</td>
<td>2 inches</td>
</tr>
<tr>
<td>Acknowledgments, pages 2+</td>
<td>1 inch</td>
</tr>
<tr>
<td>Dedication</td>
<td>center text top to bottom</td>
</tr>
<tr>
<td>Epigraph</td>
<td>center text top to bottom</td>
</tr>
<tr>
<td>Preface, first page</td>
<td>2 inches</td>
</tr>
<tr>
<td>Preface, pages 2–n</td>
<td>1 inch</td>
</tr>
<tr>
<td>Table of contents (all pages)</td>
<td>1 inch</td>
</tr>
<tr>
<td>List of tables, first page</td>
<td>2 inches</td>
</tr>
<tr>
<td>List of tables, pages 2–n</td>
<td>1 inch</td>
</tr>
<tr>
<td>List of figures, first page</td>
<td>2 inches</td>
</tr>
<tr>
<td>List of figures, pages 2–n</td>
<td>1 inch</td>
</tr>
<tr>
<td>Any other lists, first page</td>
<td>2 inches</td>
</tr>
<tr>
<td>Any other lists, pages 2–n</td>
<td>1 inch</td>
</tr>
<tr>
<td>Abstract, first page</td>
<td>2 inches</td>
</tr>
<tr>
<td>Abstract, pages 2–n</td>
<td>1 inch</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Back Matter</th>
<th>Top Margin Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appendix cover pages</td>
<td>Center title top to bottom</td>
</tr>
<tr>
<td>Appendix materials</td>
<td>1 inch</td>
</tr>
<tr>
<td>First page of references</td>
<td>2 inches</td>
</tr>
<tr>
<td>Subsequent pages of references</td>
<td>1 inch</td>
</tr>
<tr>
<td>First page of vita</td>
<td>2 inches</td>
</tr>
<tr>
<td>Subsequent pages of vita</td>
<td>1 inch</td>
</tr>
<tr>
<td>Approval Sheet</td>
<td>1 inch</td>
</tr>
</tbody>
</table>
Formatting Front Matter

Everything in your dissertation up to the beginning of the text is considered front matter. Each element of front matter has specific formatting rules. All major headings, when they appear, will be set in CAPITAL LETTERS, without bold text.

Title Page

√ Only CAPITAL LETTERS may appear on this page.
√ All of the text should be horizontally and vertically centered. To horizontally center, set all margins to 1 inch before centering alignment right to left. Be sure not to accidentally add any extra spaces/line breaks before or after the content, as it will affect the page’s overall alignment.
√ To center vertically in MS Word, use Format > Document > Layout > Page > Vertical Alignment (dropdown) set to Center.
√ There are five elements to the title page. These must be kept distinct:
√ (1) The name of the university: LOYOLA UNIVERSITY CHICAGO
√ (2) The official TITLE of your dissertation or thesis
√ (3) A CANDIDACY STATEMENT, which must be formatted precisely as shown. You may not alter the wording, spacing, or distribution of this statement, except to make it accurate to your degree:

A DISSERTATION SUBMITTED TO
THE FACULTY OF THE GRADUATE SCHOOL
IN CANDIDACY FOR THE DEGREE OF
DOCTOR OF PHILOSOPHY

Thesis students will substitute THESIS for dissertation and MASTER OF ARTS or MASTER OF SCIENCE for DOCTOR OF PHILOSOPHY.

√ (4) The name of your program: PROGRAM IN [MOLECULAR BIOLOGY]
√ (5) Author information on four lines, including the month (MAY, AUGUST, or DECEMBER) and year of conferral:

BY
YOUR FULL NAME HERE
CHICAGO, IL
DECEMBER 2022
Once they have been vertically aligned, the spacing between these elements should be 3, 5, 4, and 4. An exact example can be found below. Note that this example is made with everything in single-spacing, with all line breaks manually inserted.

Each of the elements will appear double-spaced within the element.
Copyright Page

√ Copyright rests with you, as the author of your work.

√ The copyright page will always be page ii of your thesis or dissertation, though it will not display a page number. Include the following in the center of the page, single-spaced, and with identical punctuation:

Copyright by Luke Woolf, 2022
All rights reserved.

√ Do not include any other information on this page.

√ The year, as on the title page, will be the year of degree conferral. Do not give the month.

√ Do not set your name in upper case letters.

√ Do not set this page in bold type.

√ Included in the materials you will receive after you submit your thesis or dissertation for a format check is a page about copyright policy and how it affects you. Additionally, Loyola librarians are well-versed in copyright procedures. For more information, see page 7 of the following electronically available copyright publication: https://www.copyright.gov/circs/

Acknowledgments (Optional)

This is the place to thank institutions, funding sources, libraries, archives, any readers or editors, mentors, colleagues, family, and friends. The acknowledgments, though personal, are still formal. For guidance, consult academic style manuals or books published in your field, or ask your faculty mentors.

√ The heading on this page will be ACKNOWLEDGMENTS. ACKNOWLEDGEMENTS is also acceptable, but the spelling must be the same here and in the TOC.

√ Like all main sections, this heading will be in capital letters and centered right to left.

√ The top of the heading must be 2 inches from the top of the page.

√ Pages 2+ of this section will have a 1 inch top margin.

√ This is the first page that will show a page number. The first page of the acknowledgments will be page iii.

√ Acknowledgments must be written in narrative form using complete sentences.

√ Double-space text. Do not insert extra space between the heading and text.

√ Indent the first line of every new paragraph.
Dedication (Optional)

If you choose to dedicate your work to a specific person or persons, this is the place to do so.

- The text on this page will be simple and short, comprising, at most, two lines:
  
  To Lydia
  
  Or,
  
  For my children,  
  Claus and Luka

- No heading may appear on this page.
- No page number may appear on this page.
- The dedication must be centered top to bottom and right to left.
- This is not a space for thanks or acknowledgments.

Epigraph (Optional)

An epigraph is a short quote that establishes the theme of your project.

- There will be no heading on this page.
- You may not include any explanation or clarification of the quotation on this page. You do not have to make a case for your epigraph; its content is self-justificatory. If you believe you must make a case for the quote you’ve selected for an epigraph, use it within the argument of your project, not as an epigraph.
- Do not set an epigraph in quotation marks.
- If the quotation you select as an epigraph is very well known, you may choose to refrain from providing a source.
- If you choose to provide the source, the author’s name and the text from which the quotation is taken are the only source materials you are required to include.
- The author’s name, if included, must appear on the line(s) below the quotation, aligned to the right margin. A preceding em-dash (—) is optional.
- Center the epigraph right to left and top to bottom on this page.

Preface (Optional)

A preface contains material that introduces the project but which is not part of the argument or claims that the project establishes or investigates. A preface might, for example, briefly describe the process whereby you arrived at your thesis question or statement.

- Set a top margin of 2 inches for the first page; 1 inch for any subsequent pages
- You must include the heading PREFACE on this page.
The heading will appear 2 inches below the top edge of the page, centered right to left. Page numbers will appear bottom center in lower-case roman numerals.

**Table of Contents (TOC)**

Every dissertation will be organized into chapters and will include a properly organized table of contents (hereafter TOC). If you create chapters, you must create a TOC. **You may use the table of contents for this manual as an example of a properly formatted TOC.**

- The heading TABLE OF CONTENTS will appear one inch below the top edge of the page, centered right to left.
- Each page of the TOC will have a 1-inch top margin.
- Each page of the TOC will display a page number (in lower case roman numerals) in the bottom center of each page.
- The order in which you list each item is determined by the order established by this manual, and it must be the order in which they appear in your manuscript.
- Front matter, chapter titles and back matter will appear in UPPER CASE letters in the TOC.
- Every chapter will have a generic heading (CHAPTER ONE) as well as a descriptive title (THAT WHICH WAS FORETOLD).
- The generic heading and the descriptive title must be set on the same line, separated with a colon. For example:

  `CHAPTER ONE: THAT WHICH WAS FORETOLD`

- The numeral (ONE, 1, or I) used for chapter headings must match that which appears in the text.
- Front matter entries, chapter titles and back matter entries will be aligned with the left margin (1 inch from the left edge of the page). You may not indent these items.
- Allow chapter titles to wrap naturally. Do not use a hard return in the chapter title unless a word would otherwise extend into the page number column.
- Run-over lines of all entries will be indented by 3 character spaces, or .25 inches.
- You must include page numbers for every TOC entry.
- These page numbers must be aligned with the right margin: set a right-aligned tab stop of 6.5” (by clicking on the ruler at 6.5") and then tab to get to the right column. There should not be line indicators [……….] between headings and page numbers.
- When an entry runs over to multiple lines, the page number will be aligned with the last line of the entry.
- One line of space will separate each major TOC entry from the ones that come before and after it.
If you include subheadings in your TOC, you must indicate their status by indenting them a further 3 spaces, or .25”. All subheading entries will be single-spaced.

In the TOC, you may list major subdivisions. Be consistent; if you list any level 1, 2 etc. subheadings, you must list them all.

What do you include in the TOC? You MUST list:

- Acknowledgments (if included)
- Preface (if included)
- All lists (figures, tables, abbreviations, glossary, etc.)
- Abstract (if included)
- Every chapter (generic heading and descriptive title)
- Appendices (if used)
- Bibliography or reference list
- Vita

In the TOC, do not list:

- Title page
- Copyright page
- Dedication
- Epigraph
- Table of contents

Preliminary Lists

If you have figures or tables, you must create a list of figures and/or a list of tables. If you have a list of terms, a glossary, or a list of abbreviations, it will go after any lists of tables or figures.

You may use the List of Tables at the front of this manual as an example of a well-formatted List of Tables.

- The first page of any list will have a 2 inch top margin.
- Subsequent pages (if any) will have a 1 inch top margin.
- Every page of lists will display a page number. This page number will appear bottom center, in roman numerals, 1 inch from the bottom edge of the page.
- The first page of every list will bear a heading. This heading will appear precisely 2 inches from the top edge of the page and be centered left to right.
- The heading for a list of figures will be LIST OF FIGURES; for a list of tables: LIST OF TABLES. Do not combine these lists.
- The heading for a glossary will be GLOSSARY; for a list of abbreviations: LIST OF
Abstract (Optional)

An abstract is a short description of your entire project. It offers information about your research question(s) and hypotheses, your methods, results, and conclusions, and it gives some indication of possibilities for further research or study. The abstract is a place where you can gesture toward your position in your field of study. You are not required to include an abstract in the front matter of your thesis or dissertation. However, you will be required to provide an abstract to ProQuest when you submit your final copy and, you are required to provide a PDF copy of this abstract as a supplemental file. If you choose to include an abstract in your manuscript, you must follow the following formatting rules:

- Your abstract will have a 2-inch top margin. Your abstract should only be 1-page long. If, however, your abstract extends to a second page, the second page will have a 1-inch top margin.
- The heading ABSTRACT will appear 2 inches from the top edge of the page. It will be centered left to right.
- The abstract page will display a page number, bottom center, in roman numerals.
- Text must be double-spaced. Every paragraph must be indented.

Formatting The Body Text

Chapters

The text of your thesis or dissertation produces and conveys the argument or claims that make up your project. In a dissertation, this text must be divided into chapters that will organize your text thematically and will support your argument or claims when arranged in a logical fashion.

Thesis writers whose theses are fewer than 75 pages (including all front and back matter) may consider chapter divisions optional; however, major divisions in the text will still need to be
divided in the way indicated below. If the text is not divided into chapters, it is not necessary to have a table of contents. For long theses, chapters and a table of contents can help to organize your material and to facilitate reader comprehension. For short theses with a lot of front and back matter, a table of contents that lists the body text by its title in a single entry is recommended.

Chapters must be formatted in the following manner:

- The first page of the text of the dissertation or thesis will be page 1. Page numbers will be paginated in the upper right corner of the page, 1 inch from the top and right edges of the page.
- The first page of every chapter will have a 2-inch top margin.
- The first page of every chapter will display a chapter title composed of two parts: the generic heading and the descriptive title.
- The generic heading will give the chapter number. The word CHAPTER will be followed by the number in one of three ways: typed out (ONE), Arabic numerals (1) or roman numerals (I).
- The numeral used in the text must match that given in the Table of Contents (TOC).
- The descriptive title will match the descriptive title given in the TOC.
- Do not include a colon between generic heading and descriptive title.
- The generic heading will appear above the descriptive title. It will begin 2 inches below the top edge of the page.
- Chapter titles—generic and descriptive—will appear in UPPER CASE LETTERS.
- There should be one line of space between every element of the title. For example:

  CHAPTER ONE

  THAT WHICH WAS FORETOLD

- Your text will begin immediately below the title, with only one line of space separating the two.
- The first line of a new paragraph will be indented.
- There will be no additional space separating paragraphs: use standard double-spacing with no extra space before or after lines or paragraphs. If you find that you have some additional space between lines, you should check your settings (in MS Word Format > Paragraph > Spacing > Before and After. These should be set to 0 throughout the manuscript to ensure strict double spacing is used).
Subheadings

You may choose to organize each chapter into smaller divisions by using subheadings.

- You must use the same heading hierarchy for your entire project. Follow the heading hierarchy established by the style manual appropriate to your discipline. See Appendix C of this manual for a visual guide to the heading hierarchies.
- Subheadings may not appear in UPPER CASE letters.
- Level I (or the first set of divisions under chapter titles) subheads must be centered right to left.
- You may not add extra space after a subheading.
- You may not add extra space before a subheading except when that subheading would otherwise end a page of text.
- Do not add page or section breaks between the subdivisions of your chapters, unless your subhead would appear at the end of a page. No page of text may end with a subheading.

Tables and Figures

For some projects, the addition of visual aids such as tables and/or figures can facilitate the reader’s understanding of your method, the organization and synthesis of your data, or your results. This material, however useful, is not a substitute for the argument or claims your project establishes; these visual aids only support and supplement your argument.

- Each table, figure, chart, graph etc. will have a number.
- These numbers will be whole numbers: 1, 2, 3, etc. You may not use decimal points in your numbering: 1.3, 2.3.1, etc.
- Tables will be numbered 1-n, graphs will be numbered 1–n, etc.
- In addition to the number (Table 1), each table (etc.) will also have a descriptive name or title. This title will appear alongside the number of the table, like so:

Table 2. Top Margin Requirements.

- Titles and descriptive matter for all tables (etc.) will be single-spaced.
- Do not end a page with a table title. If necessary, move the number and title to the next page.
- Keep all the material for an image (title, number, the image, descriptive matter) on the same page whenever possible.
- Do not split a table between the title and the first part of a table.
- Tables (etc.) should be placed within the text of your thesis or dissertation as close as possible to the part of the text they supplement.
Most of your readers will view your thesis or dissertation as an electronic file. Keeping images in the body of the text near your discussion of the material they contain will help readers to synthesize your work more efficiently.

For images that you do not directly discuss in your text but may nevertheless be useful for reader comprehension, you may consider creating an appendix for the reader to consult.

Whenever possible, format the text and any figures such that you avoid including large amounts of blank space.

Do not insert tables or figures in the middle of sentences.

When scaling images to meet the margin requirements, remember that most viewers will read your manuscript electronically and will be able to adjust the size to their liking. However, do not make your images so small that they will be low-resolution.

Figures should not have embedded titles; they will only be labeled with the number and title you give them.

Landscape Pages

Some tables or charts are too large to fit within the margins required for a dissertation/thesis when the page is set to portrait orientation (the orientation used for text documents). For such figures you may select to lay out certain pages in landscape orientation.

Landscape pages must be set so that when the hard copy is collated, page numbers appear in the same place as they do on portrait-oriented pages.

The top edge of a landscaped page must be set at 1 inch. This is the edge that will become the left margin when the copy is collated.

In landscape view, the page number will appear in the bottom right corner, perpendicular to the text. When the copy is collated and the page is rotated, the page number will appear in precisely the same place as on portrait pages.

The top of the graph, chart, table, etc. will appear at the top of the landscaped page: along what will become the left margin.

There are examples of properly formatted landscaped pages in Appendix D and on the Graduate School’s formatting webpage.

Sources and Citations

You must cite the sources you use in your dissertation/thesis using the style manual appropriate to your discipline. If asked, you should be able to identify the style manual you are using.

You must use the same style for your entire project.

When the rules in your style manual conflict with the rules established by this manual,
this formatting manual will supersede yours.

√ If you have any questions about the citation style used in your field, we recommend consulting your advisor or the University Writing Center.

**Quotations**

√ Use a block format for long quotations (prose extracts). What counts as a “long” quotation may vary according to style manual.
√ Block quotations will not take quotation marks.
√ Use the correct punctuation before a block quote.
√ Block quotations will be set in the same size type as the rest of your text, but they will be single-spaced. They will not be set in italics unless they appear in italic type in the source you are citing.

**Citations and Footnotes**

√ You may use footnotes if they are appropriate to your discipline. You may not use endnotes.
√ The Graduate School does not restrict the length of footnotes. If you have concerns, discuss them with your dissertation director.
√ Footnotes may be set in a size 1 or 2 points smaller than that used for the rest of the text.
√ Use the same typeface in your footnotes as you use in your text.
√ Footnotes must be single-spaced. Double-space between footnotes.
√ Footnotes should begin with ‘1’ for each chapter.

**Style Manuals**

√ Select the style manual most appropriate to your discipline or sub-discipline.
√ When your formatting question does not appear to be addressed in your manual or in this manual, the online Q&A sections maintained by some style manuals can be helpful.
√ The format check administrator is available to answer questions about style and structure. Email formathelp@luc.edu.

**Editing Help**

√ You are welcome to hire someone to format and/or copyedit your dissertation or thesis.
√ If you do hire someone to format your work, that person must follow the guidelines established by this manual. It’s best to contact formathelp@luc.edu as we can refer you to individuals who are familiar with our handbook and have done work for students in
the past.

√ See Appendix E for common issues and their solutions in Word.

√ Structure and grammar are not separable from meaning and content. The wrong preposition can undermine your project. Inconsistent heading hierarchies can mislead your reader.

√ Editing—proofreading, rewriting, formatting—can take quite a bit of time. Seek help early and budget time after you’ve finished your project for editing.

Formatting Back Matter

Appendices

Any extra materials that are necessary to understand your work must be placed within the text. Appendices contain material that further clarifies or explains elements of your project but is not necessary for understanding your argument or claims. Appropriate appendix material might include, but is not limited to, the following: raw data, letters of permission, survey questionnaires, and translations of primary material not published elsewhere. Consult your committee and authorities within your field for guidelines regarding appendices. Use the appendices in this manual for examples of a properly formatted appendices/appendix title pages.

√ Every appendix will have a cover page with a generic heading and descriptive title. The heading and title will be centered left to right and vertically aligned top to bottom. Use the same method as specified for the TITLE PAGE.

√ The generic heading will appear above the descriptive title just like chapter titles. For example:

APPENDIX B

COOKBOOKS USED WHILE DISSERTATING

√ Appendices will take designating letters (A, B, C) and not numbers.

√ The page number on every title page will appear in the bottom center of the page.

Appendix Material

√ All the material that follows the cover page will be paginated in the bottom center. They must respect margin requirements.

√ If the appendix material has its own page numbers (e.g., a scanned brochure), place your page numbers in brackets if the pagination would be otherwise confusing.

√ Appendix material must be legible; use the cleanest scans possible when reproducing materials.

√ You may not add a heading to the appendix material; the cover page is sufficient and
allows you to reproduce the material with minimal modification.

**Bibliography or Reference List**

This is the section which will list all works, primary and secondary, that you consulted while preparing your study. If you are using reference list style, then only the works you actually cite should appear in the reference list. If you are using bibliographic style, then works consulted but not specifically cited in the text of your project should be listed. You should format this list according to the guidelines endorsed by the style manual appropriate to your discipline, making any necessary amendments to meet the requirements of the Graduate School. The format you choose must be compatible with the citation format used within the text of your project.

- The heading BIBLIOGRAPHY or REFERENCE LIST will be centered, in capital letters, 2 inches from the top of the page.
- If you use reference list style, the heading will be REFERENCE LIST. If you use bibliographic style, the heading will be BIBLIOGRAPHY.
- The first page of the bibliography will have a 2-inch top margin. Subsequent pages will have a 1-inch top margin. All pages will have page numbers centered at the bottom.
- Single space within each entry; double space between entries.
- Use a hanging indent if appropriate. Many projects in the sciences will use numbers and not a hanging indent. Use the hanging indent function of your word processor to create your hanging indent. Do not use the space or tab key as a substitute.
- Every entry should include as much information as is available and as is appropriate to your field. If in doubt, more information will always be preferred to less information.

**Vita**

The vita is an account of your academic and scholarly life. You must write your vita in narrative form using complete sentences and refer to yourself by full name and/or last name. The vita need not be long or personal. It will tell readers something about your training and/or professional background, your education, and the work you finished and how it relates to your current or future work. Write the vita to be current as of the time of degree conferral. In other words, refer to yourself as having graduated from Loyola, and use “Dr.” before your name if appropriate.

- The heading VITA will appear centered and 2 inches below the top edge of the page.
- A page number will appear in the bottom center of the page.
- If your vita extends to a second page, this (and any subsequent) page will have a 1-inch top margin.
- The text on this page will be double-spaced.
- Indent the first line of new paragraphs.
EDITING YOUR DISSERTATION OR THESIS

Punctuation

In your manuscript, punctuation should be used to clarify your meaning. While it is outside the scope of the role of the format check administrator to check your punctuation line by line, sometimes punctuation inconsistencies may be noted. See chapter 6 of the 16th edition of the Chicago Manual of Style.

Dashes

There are three kinds of dashes, the hyphen (‐), the en dash (–), and the em dash (—). These are not interchangeable. See CMOS 6.75–6.91 for an explanation of the functions of these dashes.

Ellipses

You will get a cleaner presentation if you use the shortcuts/command functions to create ellipses. Ellipses should not be run over to a second line.

Colons

With few exceptions, the material that precedes a colon should be able to stand alone as a complete sentence. When the colon is used within a sentence, the first letter of the next word should be in lowercase; when the colon introduces two or more sentences, the first word after the colon should be capitalized (CMOS 6.59–6.65).

Spacing

Only 1 character space should appear after periods, colons, semicolons, question marks, exclamation points. No spaces will appear around dashes.

Lists

Lists that you create will not be indented. Run-in lists will take full parentheses: (1) is the first item, (2) is the second, etc. Vertical lists will be aligned to the left margin. If you cite a list indent it as you would a block quote.

Typefaces

Fonts like italic, bold, CAPITALIZATION, and the like should be used sparingly within your text. All text should appear in the same size font.

Quotations may not be set in italic type unless that is the way they appear in the source from which you are quoting. When you italicize quoted material for emphasis, you should indicate this.
Grammar

As with punctuation, it is outside the scope of the role of the format check administrator to check your grammar. Occasionally grammatical inconsistencies may be noted, and suggestions for improvement may be offered to help you to maintain a professional tone throughout your project.

Using a Style Sheet

Using a style sheet to track important words and phrases and formatting rules can help you to edit your own document. Keeping track of decisions in one place can help you to be consistent and may help you to edit more quickly.

Some Common Issues

Here are some very common issues that you may want to keep in mind as you make edits on your first and final versions:

- Supplementary files were not uploaded upon the initial format check submission.
- Spacing on the title page is incorrect.
- Pagination is in a different font than the rest of the manuscript.
- Pagination is in the wrong place, or it is too close to the edge. Make sure it is exactly 1” from edge of page.
- Things appear on different pages than where they are listed in the TOC. It is very common for stuff to move around as you make changes, but be sure to check and double-check the accuracy of all your TOC and preliminary lists.
- Top margins do not adjust for 2” where needed.
- Words in all caps (info on title page, chapter titles, or headers for major divisions) have typos because spell check does not check words in all caps.

See Appendix E for more common issues and possible solutions when formatting in Word.
SUBMITTING THE FINAL COPY

After your dissertation or thesis has been successfully defended, correctly formatted, and approved (with all revisions) by your director, you will deliver to the Graduate School, on or before the submission deadlines, one PDF copy of your manuscript (uploaded through ETD ProQuest), and the following supplementary files as PDFs:

1. **Approval Sheet.** On or before the final copy deadline, you must replace this with a scanned version that’s been signed by your primary advisor. This sheet must not be completed prior to successful defense. See pages 33 & 34.

2. **Abstract.** Format it like the example on page 30 of this manual.

3. **Title Page.** Format it like the example on page 31 of this manual.

All elements of your final submission must be received by the Graduate School through the ProQuest ETD Administrator on or before the published final copies deadline for the term in which you expect to receive your degree. These deadlines may be found here: [https://www.luc.edu/gradschool/key_dates.shtml](https://www.luc.edu/gradschool/key_dates.shtml)

Our deadlines are non-negotiable; requests for extensions will not be granted. The final copy deadlines are as follows:

- **MAY degree conferral:** Submit Final Copy by APRIL 1
- **AUGUST degree conferral:** Submit Final Copy by JULY 1
- **DECEMBER degree conferral:** Submit Final Copy by NOVEMBER 1

The manuscript you submit for a format check must be formatted according to the guidelines established in this manual. Your final copy submission must address all of the corrections required by the Graduate School in the format check worksheet. Your completed, formatted, approved manuscript must be uploaded on or before the final copy deadline to ETDAvministrator: [http://www.etdadmin.com/luc](http://www.etdadmin.com/luc)

Take care to submit the most recent, correct final copy to the Graduate School through the ProQuest ETD Administrator on or before the final deadline. Have all supplementary materials prepared in advance of the initial Format Check deadline. If your materials are incomplete or inaccurate, the Graduate School will notify you. Try to get your final copy submitted at least one week before the deadline, because this will leave enough time for any corrections that might be necessary. If the deadline has passed and the corrections are extensive, then the Graduate School will not confer your degree until the following conferral period.
Guide to Electronic Submission of the Final Copy

Every dissertation and thesis will be electronically delivered to the ProQuest ETD Administrator. This is part of the final copy submission process. Failure to deliver all elements by the final copy deadline may delay your degree conferral.

The information on this page is intended to guide you through the submission process to the ETD site for both format check and final copies, as well as to explain the Survey of Earned Doctorates with RTI.

Publishing Options

The Graduate School encourages you to choose “Traditional Publishing” for the electronic publication of your dissertation or thesis. This is the least expensive option (there is no cost for Traditional Publishing). Your dissertation will be publicly available in electronic form through our library, so you do not need to pay extra for open access.

Dissertation/Thesis Details

Here you will supply the title of your dissertation or thesis, the names of your committee members, up to six keywords that describe the subject matter of your project, and the electronic text of your abstract. The title you give in your ETD account must match the title you give on the title pages of your dissertation or thesis.

Copyright

Copyright registration is optional. If you choose to have ProQuest register a claim of copyright on your behalf, you will need to make a credit card payment to ProQuest in the amount of $65.

As the author of your project, copyright vests with you automatically. Just by including the copyright statement on the second page of your manuscript ensures this. Copyright registration provides an additional safeguard in the event that you file a lawsuit for copyright infringement.

Ordering Bound Copies

You may order bound copies (for a charge) through ProQuest via the ETD Administrator. You may also deliver unbound copies to the LUC library’s bindery and pay them to bind your manuscript. Information and forms available at: http://libraries.luc.edu/bindery.

Survey of Earned Doctorates

We cooperate in data collection for this project which is contracted to RTI and sponsored by the National Science Foundation, the National Institutes of Health, the Department of Education, and the National Endowment for the Humanities. If you are submitting a dissertation, then please complete this survey electronically here: https://sed-ncses.org

The Graduate School does not collect paper copies of certificates, but we will be forwarded the same confirmation email that you receive once the survey has been completed. You can learn more about the survey, confidentiality, and use of information by emailing sed@rti.org.
APPENDIX A

SUPPLEMENTARY ABSTRACT AND SUPPLEMENTARY TITLE PAGE
Robert L. Smith
Loyola University Chicago

THE FORGOTTEN WAR: THE PACIFIC THEATER OF WORLD WAR II
IN AMERICAN POPULAR MEMORY

The war fought by the United States from 1942 until 1945 in the countries within and surrounding the Pacific Ocean has often been misunderstood and sometimes been neglected in American popular memory. This dissertation attempts to trace the effects of this armed conflict in American popular culture, beginning with war movies made during the war, and continuing through the end of the Cold War. Many salient themes are present in this study: violence, race, nationalism, and the filter of popular media. I argue that interpretations of the war have been influenced by the shifting position of the media in American popular culture, and by new attitudes toward violence, race, and nationalism within the American populace.

The war fought by the United States from 1942 until 1945 in the countries within and surrounding the Pacific Ocean has often been misunderstood and sometimes been neglected in American popular memory. This dissertation attempts to trace the effects of this armed conflict in American popular culture, beginning with war movies made during the war, and continuing through the end of the Cold War. Many salient themes are present in this study: violence, race, nationalism, and the filter of popular media. I argue that interpretations of the war have been influenced by the shifting position of the media in American popular culture, and by new attitudes toward violence, race, and nationalism within the American populace.
LOYOLA UNIVERSITY CHICAGO

THE FORGOTTEN WAR:
THE PACIFIC THEATER OF WORLD WAR II IN
AMERICAN POPULAR MEMORY

A DISSERTATION SUBMITTED TO
THE FACULTY OF THE GRADUATE SCHOOL
IN CANDIDACY FOR THE DEGREE OF
DOCTOR OF PHILOSOPHY

PROGRAM IN HISTORY

BY
ROBERT L. SMITH
DIRECTOR: RHODA LEYRER, PH.D.
CHICAGO, IL
MAY 2018
APPENDIX B

APPROVAL SHEETS
DISSERTATION APPROVAL SHEET

The dissertation submitted by Robert L. Smith has been read and approved by the following committee:

Rhoda Leyrer, Ph.D., Director
Professor of History
Loyola University Chicago

Wayne Oliver, Ph.D.
Professor of History
Loyola University Chicago

Victoria Meers-Weeks, Ph.D.
Professor of History
Loyola University Chicago

The final copies have been examined by the director of the dissertation and the signature that appears below verifies the fact that any necessary changes have been incorporated, and that the dissertation is now given final approval by the committee with reference to content and form.

The dissertation is therefore accepted in partial fulfillment of the requirements for the degree of Doctor of Philosophy.

__________________________  __________________________
Date                        Director’s Signature
THESIS APPROVAL SHEET

The thesis submitted by Robert L. Smith has been read and approved by the following committee:

Rhoda Leyrer, Ph.D., Director
Professor of History
Loyola University Chicago

Wayne Oliver, Ph.D.
Professor of History
Loyola University Chicago

Victoria Meers-Weeks, Ph.D.
Professor of History
Loyola University Chicago

The final copies have been examined by the director of the thesis and the signature that appears below verifies the fact that any necessary changes have been incorporated and that the thesis is now given final approval by the committee with reference to content and form.

The thesis is therefore accepted in partial fulfillment of the requirements for the degree of Master of Arts.

________________________________________
Date

________________________________________
Director’s Signature
APPENDIX C

HEADING HIERARCHIES FOR MAJOR STYLE MANUALS
CHAPTER I*

APA HEADING HIERARCHY

This is a Level I Subheading

Level I subheadings will be centered, set in bold type, and will take Headline Style Capitalization. Do not press the “Tab” key before or after centering the heading: that will result in an off-center heading. It is acceptable to left-align the first line of a paragraph that follows a level I subhead (or a chapter title) so long as you are consistent.

This is a Level II Subheading.

Level II subheadings will be left-aligned, set in bold type, and will take Headline Style Capitalization. They will stand out more if you indent the first line of the paragraph that follows. Level II subheadings will start immediately at the left margin—do not indent them at all.

This is a level III subheading. Level III subheads will be run into the paragraph they precede. Levels I–IV will be set in bold type.

This is a level IV subheading. Also run-in. Levels III, IV, and V will take Sentence style capitalization (only the first word will be capitalized.

This is a level V subheading. Make sure that you end run-in subheads with a period. Subheads that are not run into the body of the text will not take terminal periods. No extra space will intervene before or after subheadings unless the subheading would otherwise end the page.

*Example uses chapter headings to show the distinction between headings (like chapter titles) and subheading levels.
This is a Level I Subheading

Level I subheadings will be centered, set in bold or italic type, and will take Headline Style Capitalization. Do not press the “Tab” key before or after centering the heading: that will result in an off-center heading. It is acceptable to left-align the first line of a paragraph that follows a level I subhead (or a chapter title) so long as you are consistent.

This is a Level II Subheading

Level II subheadings will be centered, set in roman type, and will take Headline Style Capitalization. They will stand out more if you indent the first line of the paragraph that follows; for long level II subheads, you may break them into two lines so that they do look like the first line of a paragraph.

This is a Level III Subheading

Level III subheads will be left-aligned, set in bold or italic type, and will take Headline Style Capitalization.

This is a Level IV subheading.

Also left-aligned. Set in Sentence style capitalization (only the first word will be capitalized), unlike the first three levels.

This is a Level V subheading. It can be set in bold or italic type. It will be run into the paragraph text. It will take a terminal period (no other subhead level in Turabian style will take a terminal period.)
SBL HEADING HIERARCHY

This is a Level I Subheading
Level I subheadings will be centered, set in bold or italic type, and will take Headline Style Capitalization. Do not press the “Tab” key before or after centering the heading: that will result in an off-center heading. It is acceptable to left-align the first line of a paragraph that follows a level I subhead (or a chapter title) so long as you are consistent.

This is a Level II Subheading
Level II subheadings will be centered, set in roman type, and will take Headline Style Capitalization. They will stand out more if you indent the first line of the paragraph that follows; for long level II subheads, you may break them into two lines so that they do look like the first line of a paragraph.

This is a Level III Subheading
Level III subheads will be left-aligned, set in bold and italic type, and will take Headline Style Capitalization.

This is a Level IV Subheading
Also left-aligned. Set in Headline Style Capitalization. The SBL student supplement does not offer guidelines for a fifth level of subheading; if you need them, follow Turabian.

Note the absence of numbers in the subheadings.
ASA HEADING HIERARCHY

This is a Modified Level I Subheading

You may not follow ASA and set your first level of subhead in UPPER CASE LETTERS; Bold type and Headline Style Capitalization will make your subhead level stand out.

This is a Level II Subheading

Level II subheadings will be left-aligned, set italic type, and will take Headline Style Capitalization.

This is a level III subheading. Level III subheadings will be run into the paragraph they precede. They will be indented (as for a new paragraph) and will be set in italic type with sentence style capitalization. If you require more levels for your project, follow APA instead.
CSE, MLA, and CHICAGO STYLE SERIATION

If the style manual adopted by your discipline does not describe a preferred heading hierarchy, you have several options:

1. Consult the major journal(s) in your discipline (PMLA, Proceedings and Addresses of the American Philosophical Association, Science Editor, etc.) to find if the journal put out by the discipline has guidelines for seriation.

2. Follow one of the above hierarchies, choosing the one most appropriate to your discipline and project.

3. If you have a compelling reason to do so, you may (with the approval of the format check administrator) create your own heading hierarchy.
The top margin of a landscaped page, like the left margin of a portrait pages, must be 1 inch. The tricky part is that page numbers on landscaped pages must be oriented so that they appear in the correct position when the document is printed/rotated. One way to do this is by inserting a text box (Insert > Text Box), placing the box in the correct location, and manually typing the page number into the box. This will need to be in its own section, and you can rotate this page number using the rotation arm on the text box. Insert a section break before and after the landscaped page. You can turn a page into landscape view by going to Format > Document > Page Setup (on the bottom) > Landscape. It is recommended that you have landscape pages rotated in MS Word so that the text is readable in electronic copy; however, you may keep the page portrait and insert your table rotated, if you prefer, as it is generally easy to rotate pages in a file viewer.
APPENDIX E

COMMON FORMATTING ISSUES AND THEIR SOLUTIONS
General Issues

How do I know where my section breaks or line breaks are?

If you are working on your formatting, be sure to display formatting in Word. This is the “show/hide” button found here. Displaying formatting will help you see otherwise invisible formatting. These format markers will not print or display in a PDF. In addition, you may want certain information to show in your window at the bottom left. Near your word count, character count, or page count, right click and select any categories (like Sections) that you’d like to display on your window.

I cannot get my page to look like how it is supposed to.

The advice and information in this manual will only work if you have margins set to 1”, with standard size (8.5x11) pages. Note that you may need to check the settings in each section, as margins will sometimes automatically start at another value in a new section. In almost all of the manuscript, you should have your spacing settings set to double spaced without additional points before or after (Format > Paragraph > Spacing > Before and After at 0pt and Line Spacing at Double). Only in a few places should Line Spacing be set to Single in the body text, such as block quotes or table titles; front and back matter have several places using single-spaced, like the title page, as discussed on pages 11 and 12. If you are still having problems with your page format, check the indent and stop-gaps located on the ruler at the top of the page. These should normally be set to the margin locations and regular .5” indent locations.

I have extra space between my paragraphs or headers but my line spacing is already set to double-spaced.

This is a common problem. Highlight the problem area (or the entire section). You will want to highlight multiple lines if this is an issue between lines. Then go to Format > Paragraph > Spacing > Before and After. These should be set to 0, not “auto” or any number of points. Note that the manual asks you to have your draft set to double-spaced throughout (with the exceptions being listed on page 7). This means that if your settings are set to double-spaced, there will be NO ADDITIONAL blank lines between lines of text, whether it is between your header and body text or between paragraphs. So, for example, this line and this line are single spaced.

This new line

and this line are double-spaced width apart. This exact distance will be the distance between all regular body text lines and between headings and your body text.
I have my title page/copyright page/dedication/etc. centered vertically but it is not appearing at the very center of the screen.

If you have your page centered vertically, firstly make sure there are no extra line breaks above or below the text you are trying to center. These line breaks count in the “weight” of the page. Make sure your margins are set to 1” on all sides and there are no extra indent/margin markers on the ruler above the page. If your centered page is causing other pages to appear differently, make sure the text is in its own section by using Insert > Break > Section Break (Next Page) before and after the text you are wanting to center.

Page Numbers
My page numbers are appearing in the wrong place or in multiple areas on the page.

If you are dividing your manuscript into sections using section breaks, each section should be formatted separately. In each section, you will want to pay attention to the settings in the header and footer, which is where your page number will be. Double-click in the header or footer. Turn off “Link to Previous,” found in the toolbar under Header & Footer. You can then delete out the page number that is in the incorrect spot, or add the page number to the correct location. Make sure you check each section for these settings, as Word automatically links your section to the previous section. (Linked sections are governed as if they were one single section). You should be able to manually set the page number to be 1” from the edge, or you can drag the page number to the correct location. Note that you need consistency between page number locations between sections, so if you drag the page number, you must be exact with your placement.

My page number is the wrong number.
Double-click into the footer or header where the page number is incorrect. Double-click the page number. In the Header & Footer toolbar, find the “Page Number” option and click “Format Page Number.” You might also find this option in Insert > Page Numbers…> Format…. Either change your setting to manually start at the right page number for that section, or click “Continue from Previous Section.”

My page numbers are on top of the top line of text on the page OR my bottom page numbers are on top of my last line of text.
This will happen if your text begins exactly at 1”, or directly at the margin. Depending on other settings, you may wish to push your top margin to 1.1” or so in the body text sections, so that your first line begins ever so slightly under the 1” mark to distinguish your page numbers from text. Your margin should still appear very nearly at 1”, with your page numbers set off from the text.

Section Breaks
How do I know when to use a section break, or which type of section break to use?
Section breaks should be used any time you need to start using different formatting settings than the page before. Insert > Break > Section (New Page) will start the new section on the next page. Note that the footer of the page where this is inserted will still be considered the previous section. Insert >Break > Section (Continuous) can be used in the middle of body
text if you anticipate further changes to your text, as it can be rolled forward or backward without creating new pages.

I cannot remove a section break.

Section breaks are tricky to remove in many versions of Word. There are two ways I recommend removing them. First is to highlight the area around where the section break occurs. “Cut” this text either with Right Click > Cut or with Control/Command X. Paste the text back in (Right Click > Paste, or Control/Command V). When the “Paste Options” icon appears (which looks like this ▶️) select Keep Text Only. This will remove the section break. The other option is to Edit > Find > Replace… You can search for section breaks by searching for ^b. When you’re sure you have the right section break selected (by clicking find multiple times), replace the section break with nothing. This will delete the break.

THE END